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Welcome to the Vectorworks Architect 
2012 Getting Started Guide! This guide 
is designed to provide you with a strong 
base as you learn to use Vectorworks 
Architect to design, communicate, and 
document the built environment.

This guide cuts to the heart of Vectorworks, 
explaining the concepts and methodologies 
you need to develop improvisational skills 
so that you can be efficient and, perhaps 
most important, you can be successful 
at realizing your most inspired visions.

This guide presents the tools, commands, and 
other details of the software in the context of 
workflows, which are the discreet steps taken 
with the software that accomplish a specific 
architectural or design task. A workflow 
takes a familiar architectural task, such as 
creating a massing model from a series of 
planar elements, and presents commentary, 

demonstration, and example steps to 
accomplish the task and apply the skill in 
the course of your practice. This concept 
forms the bridge from traditional architectural 
processes to the software implementation 
details and best practices used to model 
these processes in Vectorworks Architect.

The workflows used in this guide are 
selected for the learning opportunities they 
present. There are often multiple workflows 
that deliver the desired result. A unique 
feature of this guide is the examination of 
the benefits and drawbacks of alternate 
workflows. This discussion will help you 
develop workflow strategies of your own.

The Vectorworks Architect Getting Started 
Guide is essential required reading for all 
AEC industry professionals—from first-
time users to the most experienced.

How this guide is organized

As with most tools you need a familiarity with 
multiple disparate topics to work effectively 
with Vectorworks Architect. This guide has 
several features that make it unique in its 
ability deliver information about these skills.

The topics are integrated into the exercise 
so that you can see the workflow as a whole. 
However, it is also necessary to factor out 

each topic at times so that you can examine 
it on its own and recognize its purpose and 
benefits as you use it throughout the exercise.

The benefit to you, dear reader, is that you 
can focus on a particular topic by following 
a system of linked icons. We will explain 
these in the next section. Of course, we 
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Interface Elements

Lets begin with a quick description of the 
interface elements in Vectorworks Architect.

Document Window
The largest region in the center of the display 
is the Document window. The Document 
window is tinted with subtle colors to indicate 
the projection. For example, the Document 
window is cream for Top/Plan and light 
green for 3D views. You'll see a pure white 
background for sheet layers. The Document 
window also (optionally) displays various 
types of coordinate grids, which identify 
working planes as they are projected in the 
Document window. The print page boundary 
is shown as a light gray rectangle and can 
show additional divisions to indicate the tiling 
that will be performed when printing an area 
that is too small to fit on a single page.

Menu Bar, View Bar, Tool Bar, and 
Message Bar
Immediately above the Document Window 
are three horizontal control strips. At the 
very top is the Menu bar and below that, 
the Title bar, which displays the file name 
of the Document window contents.

Below these two bars is the View bar, which 
is the “status dashboard” of Vectorworks 

Fundamentals. Always check the View 
bar to help understand the context of what 
you're looking at in the Document window. 
The visible controls in the View bar are 
shown with a checkmark in the list of View 
bar elements under the small arrow in the 
right-most position of the View bar. You can 
customize what is shown in the View bar with 
this list, but for now, we'll leave it alone.

Below the View bar is the Tool bar. Whenever 
a tool is selected, the Tool bar offers mode 
buttons that control how the active tool will 
work. In addition, check for instructions to the 
right of the mode buttons, which explain what 
to do before each step as you use the tool.

Framing the Document window vertically to 
the left and horizontally below the Tool bar, are 
rulers to help you understand the size of the 
area displayed in the Document window as 
you zoom and pan about within the Document 
window. The rulers can be hidden with a 
preference setting to save screen "real estate."

Across the bottom of the Document window 
is a gray strip where general help appears 
to the left and the coordinates of the cursor, 
to the right. Watch the right part of this bar 
for minor alerts in red and the progress 

Section 2
Commentary

recommend that you work through this 
guide straight through at some point.

The Example in Section 3 is the heart of the 
guide and explains the hows and whys of 
Vectorworks Architect. It puts into context 
usage of the tools with the emphasis on best 
practice workflows in a complete project. 
Embedded videos follow each group of 
written steps— exactly, but without the 
important tips and notes in the text. In case 
you end up with an unexpected result after 
one of the steps, you can review the video 
immediately. At the end of each chapter is the  
Further Exploration section, which highlights 
common workflow variations that may not 
have been encountered in the Example.

This guide is written as a companion to 
the help system, which does not contain 
step-by-step procedures. The help system 
serves as a comprehensive reference for 
the tools, commands, and dialog boxes that 
you will encounter here in this guide and 
layer as you use Vectorworks Architect for 
your projects. Indeed, you are encouraged 
to read through the parallel material in 
the Vectorworks 2012 Help application 
when you want more information about a 
specific element being used in this guide. 
A link to the help system is provided at 
each tool and command for this purpose.

The workflows in this guide have been 
developed to give you the experience of using 
Vectorworks' Architect integrated snapping, 
hybrid, cursor and other systems to draw 
fast and accurately as you solve visual and 
geometric design problems. It's a lot to digest 
all at once, yet it can be quite unsatisfying if 
you aren't using these features in concert. So, 
as you practice with Vectorworks, imagine 
improvising a solution to the tasks before you 
using various combinations of these features 
together. Those who succeed always embrace 
the tools to enhance their personal approach. 

Still, it often is quite overwhelming to 
beginners at first, so take it in small pieces: 
Watch the videos that accompany the steps 
to see a practiced hand doing them. Then try 
the step over again so you'll get the sense of 
how the different parts are used together.

Also, it may help to think of using the various 
features linearly to get the job done. For 
instance, drawing a few extra guidelines can 
go a long way toward building the workflow 
in your mind as you work. The main thing is 
to understand and embrace the goal of using 
Vectorworks' Architect systems efficiently.
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bar to estimate time remaining during long 
operations such as rendering and importing.

Tool Hot Keys/Menu Shortcuts
Tool hot keys are listed in the tool tip that 
appears when you mouse over any tool. 
A hot key is one or more keys without 
the command key (Mac) or Control key 
(Windows) modifier. For example, to activate 
the rectangle tool, simply press the "4"; to 
activate the selection tool press the "x" key. 
(This is the "4" key in the row of numbers 
across the top of the keyboard, not the "4" 
in the numeric keypad, if you have one.

Menu shortcuts are listed across from the 
menu name each time you issue a command 
in the menu bar. Similar to the tool hot 
keys, are the menu shortcuts which can be 
entered on your keyboard to invoke menu 
commands without moving the cursor.

In this guide, the term pointer is used to 
select the menus and tools throughout 
the instructions. We feel that this method 
gives you more obvious feedback as you 
become acquainted with the software. Even 
self-taught folks generally start out with 
the interactive input methods used in this 
book. You can use the tool hot keys and 
menu shortcuts interchangeably with the 
pointer methods described in this guide.

Many hard-core users incorporate the 
menu shortcuts and tool hot keys at some 
point along the way, once they are more 
familiar with the software. Either way, or 
a mixture of each method, can be best 
for you. The results are identical.

The complete list of all the shipping 
tool hot keys and Menu Shortcuts can 

be found in the User Guide located 
in the Vectorworks Help menu.

Workspace
The general look of the controls around 
the document window is determined by the 
workspace. In Vectorworks, a workspace is 
an arrangement of tools, menus, and perhaps 
most importantly, the customizable shortcuts 
and hot keys assigned to select menus, tools, 
and certain other functionality, without having 
to use the pointer. For some users, using 
the keyboard more can streamline many 
tasks. You can customize your workspace 
with the Workspace Editor, so you can adapt 
parts of Vectorworks' interface to suit.

We will be using the shipping workspace 
throughout this guide, however, so please 
don't change it at this time. It is worth noting 
that the shipping workspaces have been 
developed over time and have been given 
a substantial amount of thought by folks 
who are intimately familiar with the use of 
the software. Therefore you might want to 
continue using your workspace for a while 
to discover the logic behind its layout.

If you are coming to Vectorworks after 
using other software, you will find that, 
while the result that you expect from either 
product is identical, ideally the way that 
you use Vectorworks to achieve this result 
is substantially different. This is because 
Vectorworks, as with any software, presents a 
unique user model. This makes applying the 
approach of other software inefficient at best. 
A classic notion is to come to Vectorworks 
expecting to use the methods learned on other 
systems. So, bring your high expectations, but 

make sure you leave your old methods behind 
while you get up to speed in Vectorworks. 

Palettes
The illustration above is a screenshot of the 
Vectorworks Architect workspace. To the far 
left are the tool palettes where you'll see rows 
of tool icons. All those little tool icons can 
be intimidating when you're first starting out, 
but we'll get you up to speed in short order. 

At the top is the Basic tool palette. This is 
the palette that we'll be using mostly, at first. 
Notice the black arrow in the upper left of 
the Basic tool palette, which when you click 
on it, makes the cursor look like the normal 
system cursor. This is the Selection tool. 
Vectorworks always has a tool selected, even 
if it is the Selection tool. The modes of the 
selected tool will be visible in the Tool bar. 
Below the Basic palette is a special palette 
called Tool sets, which is a pallet of pallets 
organized by task. We will visit this palette 
occasionally in the Exercise. Which palettes 
and tools that you see here depends on 
which Vectorworks product is installed.

To the right of the drawing window is the 
Object Info palette. This palette reports 
the parameters, such as the size or 
location of the selected object(s). You 
can edit the parameters of a selected 
object with the Object Info palette as 
well, which causes the selected objects 
to adjust according to the new values.

Below the Object Info palette in the lower 
right corner of the display is the Navigation 
palette. There are seven tabs representing 
the different organizational structures that 
Vectorworks offers. You will use these to give 
graphic, logical, and geometric properties 
to the objects in your project. Imbuing your 
projects with enough structure, (but not 
too much) makes the job of adjusting the 
presentation of the project much easier, 
especially late in the design process.

Preferences
In Vectorworks, you can use a category 
of preferences called Vectorworks 
Preferences to change the way the program 
interacts with you. In fact, many of the 
settings, are used to let Vectorworks work the 
way it used to work in previous versions. It 
is worth noting that the shipping preference 
set has been developed over time and has 
been given a substantial amount of thought by 
folks who are intimately familiar with the use 
of the software, so you might consider using 
most preferences the way they are installed, 
at least for a while, to take advantage of 
this collective experience. Nevertheless, 
these preferences are provided so that you 
can adjust them to your preference.

All Vectorworks Preferences apply to your 
account on a specific machine. Vectorworks 
writes separate preference sets for 
each account on the same machine.

Another category of preferences is Document 
Preferences that apply to individual files. 
This preference set has items that you 
may need to adjust so that certain special 
purpose files behave appropriately. Once 
you have identified the need for any of these 
preferences, you can make a template or 
stationary file with any document preferences, 
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representing the shape that the curb follows, 
and a profile, which is a planar object in 
the form of a section through the curb. 
The Extrude Along Path container object 
uses these definitions to compute how 
the section looks as it follows the path. 
At any time later, you can access either 
the path or the profile independently to 
greatly simplify making design changes 
that the container will subsequently use.

This concept is incorporated into all sorts 
of objects in Vectorworks, and once you 
become familiar with the behavior of one 
type of container object, you'll know what to 
expect whenever you encounter other types.

Hybrid Objects
When working in Vectorworks, it is usually 
desirable to use hybrid objects because their 
properties make them able to have schematic 
graphic properties and realistic, fully detailed 
properties, as well as customizable non-
graphic properties such as pricing and 
materials. Hybrid objects combine the 
properties of 2D and 3D and are created with 
separate definitions for how they look in a plan 
view and how they look in other projections. 
When viewed in a 2D plans,  the schematic 
representation of the object is seen. When 
viewed in perspective or in another view 
such as an isometric projection, only the 3D 
portion is seen. Anyone using Vectorworks 
to show clients pre-visualizations, and later, 
fabricators how to build those designs, 
can benefit from using hybrid objects.

Information Modeling
In Vectorworks, information modeling is a 
process that enables designers to model a 
project that provides data to fully support 
the sharing of building model geometry and 
data with all parties involved in a buildings 
lifecycle, in addition to the traditional 

takeoffs, and 2D graphic representations. 
The model components are consistent 
through means of non-redundant data and 
structured hierarchies so that the project 
can be understood, shared, and coordinated 
by stakeholders and represented to each 
other throughout the building cycle.

Stacking Order
As objects are drawn, the program keeps 
track of their stacking order within the 
design layer. The first object created is at 
the back of the stack, and the most recent 
object created is at the front of the stack.

The send commands change the stacking 
order of objects within a layer. Objects 
can be sent forward to be in front of an 
overlapping object or sent backward to 
be behind an overlapping object. Also, 
objects can be sent all the way to the 
front or back of the stack in one step.

Although this applies to all objects, the 
stacking effect is only seen when the 
projection is Top/Plan, and only with planar 
objects having a fill attribute other than none. 
Nevertheless, this feature is used to great 
effect throughout the design process to 
construct, create, and edit figures for details, 
plan projections, and viewport annotations

Working, Automatic, and Layer 
Planes (Screen)
In Vectorworks, when manipulating objects 
in space, snap points of existing 3D objects 
always override the other alignment and 
positioning mechanisms described here. 
This is desirable most of the time, so this 
is the default. Otherwise, Vectorworks 
requires a plane in space so that clicking 
on the "flat" display can be calculated 
to intersect somewhere before infinity. 

which opens a copy of the template with the 
document preferences already applied.

Common Computer Conventions in Vectorworks

Many conventions common to most software 
are found in Vectorworks. As in word 
processors, email clients, and spreadsheets 
everywhere, these functions work as 
expected in Vectorworks Architect, as well:

• Delete: Select an object and press 
the backspace or delete key.

• Undo: If you make a mistake, 
choose Edit->Undo

• Copy, Cut, Paste: All of these conventions 
are present and work in Vectorworks 
in a familiar, reassuring way.

Common CAD Concepts

• Selection: Use the Selection tool to select 
objects, to move and resize objects in any 
view, and to insert objects in or next to a 
wall. From the Basic tool palette, select 
the Selection tool, move the cursor into the 
document window, and click on an edge of 
an object. While you are puttering about in 
the Document window, each time the cursor 
crosses the edge of a selectable object, 
Pre-selection Highlighting indicates any 

objects that would be selected. To deselect 
or select more than one object at a time, 
click the pointer while holding the Shift key.

An additional method, marquee selection, 
allows you to select any number of objects 
within a region on the screen. Press the 
Option (Macintosh) or Alt (Windows) key 
while dragging with the pointer button 
depressed. This will toggle the selection 
state of all objects that are within the 
region or that intersect the marquee.

Vectorworks Key Concepts

Container Objects
Container objects make creating and editing 
some types of representations more flexible 
because the simpler defining objects that 
comprise the container are stored as part 
of, or within the container. The benefit of the 
container concept is that you can revise or 
later replace simple defining objects inside the 
container without having to rebuild the object 
represented by the container from scratch. 
So, container objects store easy-to-edit 

objects as parameters, that can be used to 
refine or redefine the container at any time.

For example, to make a curb around a patio, 
you might imagine creating straight lengths 
of stock and somehow mitering the strips 
at each bend. Following a curve presents a 
challenge, as does the prospect of making 
a change later to the shape of the patio. 

Instead, a container object called Extrude 
Along Path can be used to store a path 
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of all objects are expressed relative to the 
active layer plane. Other layers are above 
or below the active layer, depending on their 
elevation’s relationship to the active layer.

The active layer’s layer options setting (View 
> Layer Options) determines whether other 
layers can be rendered and snapped to, 
and whether objects on other layers can be 
selected and modified. For rendering, select 
Show Others or Gray Others. For both 
rendering and snapping, select Show/Snap 
Others or Gray/Snap Others. When Show/
Snap/Modify Others is selected, objects on 
other layers can be selected and modified.

Tool Behaviors and Modes
There are several features that are offered 
across all tools that can help you to draft 
fast and accurately. First off, most tools 
have a keyboard shortcut that is displayed 
in the tooltip as you hover over the tool with 
the pointer. Next, once the tool is selected, 
it is quite useful to either verify or select 
the desired mode in the Tool bar. Mode 
selection can be done with the pointer, or 
it can be controlled with the universal Tool 
bar shortcut set. (image of labeled modes)

Most tool operations are executed with a 
series of clicks. You'll find instructions in 
the Tool bar to the right of the mode button 
prompting you with what to do next. Each 
click of the cursor in Vectorworks means 
pressing the pointer button and releasing 
it. Once the desired tool has been selected 
and the mode has been chosen, move 
cursor into the drawing area and click, 
while interacting with the objects on the 
page until the tool operation is finished.

1. Tool types
Many tools can be categorized by the 
number of clicks they require for execution. 

The rectangle tool is an example of 
a two-click or line-based tool.

Let's demonstrate the use of this tool: Click 
once on the rectangle tool; click once on the 
first button in the Tool bar (rectangle mode), 
and then move the cursor into the drawing 
area. Click once, releasing the pointer button 
and move the cursor down and to the right. 
As you do this, you'll see several interface 
features. The dashed diagonal line indicates 
the rectangle's length and width. The Floating 
Data Bar shows the height and the width 
labeled ∆X (Mac) or ±X (Windows) ask for 
the width and ∆Y (Mac) or ±Y (Windows) 
for the height. A negative value indicates 
the downward direction for the Y-axis and 
a leftward direction for the X-axis. Several 
common features are available as you 
work with tools in Vectorworks. At any time 
during the operation, no matter how many 
steps you've taken so far, you can press the 
Escape key to cancel the operation. This 
action, however, is not undoable because 
as yet the object has not been formed. So, 
Vectorworks makes a distinction between 
objects that are existing, which you can 
delete, and objects that haven't been fully 
formed, which you can escape but can't 
undo if you were to decide to continue.

2. Floating Data Bar
Another useful feature is the blue box , 
called the Floating Data Bar, that follows the 
cursor as you work on the screen. Its the 
blue outline that has data actions which are 
relevant to the operation. In the case of the 
rectangle you'll see the ∆X on (Mac); ±X on 
(Windows) in the ∆Y ±Y on (Windows) which 
both give the values of the horizontal and 
vertical direction at any time. You can type 
the number on the keyboard from the row 
of numbers across the top of the keyboard 
to begin editing the first value, which in this 
case would be the X value. So just pressing 
the 5 key begins entering information into 

Therefore, all object creation, editing, and 
moving is aligned to a working plane.

A working plane is an elevation of any height 
on a plane of three points at any orientation 
defined by the user. Often, the user will 
define a working plane to make aligning and 
positioning tasks easier and more accurate. If 
the working plane is not explicitly defined by 
the user, then the location of the working plane 
defaults to that of the Active Layer plane.

Every Vectorworks layer has a horizontal 
plane and elevation associated with it that 
you can set relative to the internal fixed 
plane known as the Ground Plane.

The Ground plane is a fixed horizontal plane 
with its origin at the center of the drawing 
space and at the level of the printed paper. 
Ultimately, the Ground plane determines 
how the location of any point is listed.

There are several functions that can affect 
this behavior, however. Objects in layers 
with an offset to the ground plane report 
their height relative to their layer plane 
whether or not the layer plane is offset from 
the ground plane. So, when not defined by 
you, the working plane defaults to the Active 
Layer plane, which may be 0, when the 
working plane is called the Ground plane.

As you are working in Vectorworks, you 
may want an object to respond to a working 
plane that is not horizontal or defined by 
any other saved planes. For example, you 
may want to align solar panels to a sloped 
roof. In this case, you can define a working 
plane that is parallel to the roof face and 
when it is active, all creation, editing, and 
movement is observed relative to the active 
working plane. Once it has been defined, it 
can be saved and reused later. Working in 
3D requires a plane in space so that clicking 
on the "flat" display can be calculated to 
intersect somewhere before infinity.

So, in summary:

• All editing and creation in 3D space 
happens in the Working plane.

• The Working plane may be aligned with an 
Active Layer plane or the Ground plane

• Snap points of existing 3D objects always 
override the Working Plane, otherwise, 
there will always be an active plane.

• Working in 3D requires a plane in 
space so that clicking on the "flat" 
display can be calculated to intersect 
somewhere before infinity.

• All 3D tools and most planar tools can 
dynamically set working planes for the next 
drawing operation. This makes controlling 
the working plane very manageable.

• The Screen plane is a legacy concept 
that continues to have narrowly 
defined uses, but is not used in the 
everyday modeling workflow.

Unified View Integrated 
Environment
The Unified View command accesses a 
modeling mode to view, snap to, select, and 
edit objects in multiple design layers within 
one coordinate system. This mode is active 
by default to see the entire model and edit 
multiple objects across layers easily, or to 
align objects across layers, without having 
to create a viewport or use layer links.

While in Unified View, Vectorworks aligns all 
visible design layers in the drawing file with the 
active layer as you navigate in the document 
window, and displays them using the active 
layer’s scale, lighting options, render mode, 
and Renderworks background (Renderworks 
required). The unified view also provides a 
unified coordinate system; the Z coordinates 
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This project takes for its inspiration a landmark Modernist work designed by the late Chicago 
architect Harry Weese. Built to house the Advances in Molecular Biology Conference 
sponsored by the University of Colorado School of Medicine, the Given Institute consisted of 
a series of angular volumes configured around a circular medical theatre-inspired auditorium. 
It was eventually demolished.

We have selected this building for its historic importance and in part for its geometric 
concept. The schematic design phase will begin with the central auditorium space—a simple 
circle. Then, using Vectorworks' guides and snap     categories, we work out the preliminary 
layout, based on geometric relationships to the auditorium. These guides will be created with 
planar objects such as circles, triangles, and squares. Once the plan form is worked out, the 
guides are transformed to massing volumes.

Once mastered, this process can join traditional methods to explore forms and space. In fact, 
designing with a digital tool can effect improvements over traditional markers and cardboard 
in two important ways:

Section 3
Example

the X field. Any number across the top of 
the keyboard can be used to enter the data, 
however, the numeric keypad will not work 
with the Floating Data Bar as these numbers 
are designated as shortcuts for displaying the 
standard views. Once the first field is filled 
out, pressing the tab key on the keyboard will 
move the cursor to the next field where you 
can assign values as well. This is an extremely 
intuitive and useful method to accurately enter 
precise values as you draw. Once the value 
has been entered you can end by pressing 
the enter key or by clicking the pointer 
once and releasing it to finish the drawing 
operation. After the 2nd click has been 
completed the object now exists in a selected 
state on the drawing and its information 
is displayed in the object info palette.

3. Location and Rotation type.
A variation of the two click tool behavior is 
the location and rotation type. An example of 
this type of tool is the column tool found in the 
walls tool set. There are two clicks with this 
tool as well, once it has been selected. Click 
once on the tool and once in the first button of 
the Tool bar (standard insertion mode). Bring 
the cursor into the drawing area, and you'll 
see a small cross-shaped figure in dashed 
lines. Click once to set the location, then make 
a small circle with the cursor around your 
click point, and you'll see the dashed figure 
rotating with the pointer. When the figure is 
rotated as desired, click a second time to set 
the rotation. Most of the objects of this type 
represent a real-world object, and the first 
time such a tool is used in a particular project, 
the object properties dialog box appears after 
the first insertion. You can fill out values here 
to define the default sizes of the column for 
subsequent uses. If you're following along, just 
click the OK button of the object properties 
dialog to see the finished column. The column 
is inserted at the specified location, and 
rotation, and is left selected. The properties 
of the column are displayed in the Object Info 

palette. As you move the cursor away from 
the new column, you will see the dashed 
outline of another potential column following 
the cursor, and you are ready to begin the 
location and rotation sequence once again.

4. Single-click tools
We'll go over to other types of tool behaviors 
before moving on. There is a single-point tool 
behavior exemplified by the 2D locus tool 
from the basic tool palette. The tool's icon 
looks like a small x in the second row. There 
are no modes for this tool, so there are no 
buttons in the Tool bar. Since this tool is a 
single-click tool, each time you click with the 
pointer produces a new locus in the drawing.

5. Multi-step tools
The final kind of tool behavior that will 
demonstrate for moving on is the multi-step 
tool. This type takes an arbitrary number 
of clicks determined by your needs of the 
moment. The polygon tool possesses this type 
of behavior, so we'll select it from the basic 
tool palette. Click once on the tool. Click once 
on the first button in the Tool bar that creates 
polygons from vertices mode, and bring the 
cursor into the drawing. Click once to start 
and move the mouse away from the star point 
to see a vertex line segment forming. Each 
click as you move the cursor away from the 
point produces another line segment, which 
can be ended by clicking once on the start 
point or double-clicking in whitespace.

We will encounter many opportunities to use 
these tool behaviors in the exercise. Feel 
free to take a moment for a bit of practice 
with simple point, line, and multi-step tool 
examples that will help you incorporate speed, 
accuracy, and documentation techniques. 
Feel free to browse through the exercise file 
or skip ahead to the project. You can always 
come back to something that you've missed.
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Display and Dimensions tab, set the 
Length to Feet and Inches or 
Centimeters.

2. Right-click (Windows) or Control + Click 
(Macintosh) in a blank area of the 
document window. In the context menu 
that appears under the cursor, choose 
Active Layer Scale. In the Metric/
Engineering group, choose the 1:50 
option, or in the Imperial group, choose 
the 1/4" option.

3. Choose File>Print Setup...(Windows) 
or File>Page Setup...(Mac) in the 
Printable Area group on the right side of 
the Setup dialog, Set the page size to 
"ISO A1" or "Arch D". You may have to 
check the "Use size unavailable in 
printer setup" box to enable these 
choices. You can find a detailed 
commentary on printing setup in 
Vectorworks Architect in the Appendix.

4. In the Pages group on the left side of 
the Page Setup dialog, Check the 
"Show Page Boundary" box and 
uncheck the Page Breaks box.

Adjust the Preferences
So that there can be a standard base line, 
we will reset the preferences and constraints. 
We will use the standard Preferences and 
Constraints for the most part, but we will 
change a couple of options in each:

1. Choose Tools>Options>Vectorworks 
Preferences…

2. In the Vectorworks Preferences dialog 
box, choose the Reset button.

3. Accept the alert dialog box that appears 
by clicking the Yes" button. The dialog 
will close.

4. Once again, choose 
Tools>Options>Vectorworks 
Preferences.

5. In the Vectorworks Preferences dialog 
box, choose the Display tab.

6. Choose the Center on objects after 
view change checkbox.

This preference avoids sometimes mystifying 
disappearances of the onscreen objects 
when switching views for—example, from 
top/plan to isometric. Usually, it just takes a 
zoom out or a Fit to Objects to display the 
objects again, but why take the extra step?

Benefits of Designing with a Digital 
Tool
• Using digital techniques, the geometry 

created in one step is used directly in 
the next step to create massing, which is 
used to generate architectural elements 
in the next, and so forth, saving time and 
creating continuity throughout the process.

• Vectorworks dynamically associates 
building information with the model that 
is produced by the design process. 
Areas, quantities, volumes, and 
other measurements are available 
to the designer to inform decisions 
all along the way. Ultimately, these 
data–loaded objects form the basis of 
the architect's contract deliverables.

This guide will show you how to design using a familiar architectural process while embracing 
modern Information Model principals.

Let us now begin with a few initial settings.

An extensive setup is not necessary to begin working in Vectorworks. We will add organizational 
structures, such as new Classes, when needed as we go. Of course, carefully planning the file 
structure becomes essential when contemplating a large project or a team. Beginning with a pre-
built template can also help maintain drawing organization and graphics standards across 
projects. When this project is completed, we will have a complete drawing organization. Initially, 
we will only set a few options for convenience. You can find a detailed commentary on Drawing 
organization and the new Stories feature in Vectorworks Architect 2012 in the Appendix.

To tailor Vectorworks for the design process tasks in this section, however, we will set a few 
preferences and constraints. Follow the steps below or open the start file in the Exercise folder, 
1-GSG-ARCH-IMP-START, and skip to the step labeled 'Adjust the Preferences' below:

Quick Drawing Setup
In Vectorworks, choose File>New... and then 
select the Create blank document option in the 
Create Document dialog box.  
 
Click the play button below to view 
a video of the following steps. 

1. Choose File>Document 
Settings>Units... In the General 
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Initialize the Guides System
1. Choose Modify>Guides>Show Guides
This command creates a class 
called "Guides", which can easily be 
managed with the commands under 
the Modify>Guides menu. The Guides 
system manages the display of objects 
simply by manipulating the "Guides" class 
attributes. A complete commentary on 
Classes and other document organization 
features is located in the Appendix.

2. From the Active Class popup located in 
the View bar, select "Guides".

This popup menu in the View bar displays 
the Active class. Since all new drawing 
operations are placed in the Active class, 
the objects created in the next steps will be 
placed in the  "Guides" class. When there is 
a selection in the drawing, a similar popup, 
displayed on the Object Info palette, indicates 
the assigned class of the selected object. 
So, the item displayed in the View bar Active 
class popup is assigned to everything that is 
created new in the document. Use the Class 
popup in the Object Info palette to re-assign 
an existing object to a different class.

 

Planar Workflow

Preliminary Layout
The site is in Aspen, Colorado, on 
a gently sloping parcel. Several 
"program requirements" follow:

• The building is to be used to accommodate 
conferences of medical professionals 
to present new findings in the field. 
These are usually held during Aspen's 
snow-free months, since most attendees 
are on an academic schedule.

• The building should accommodate 
150 conference attendants who make 
use of various functional spaces with 
proposed square areas as follows:

• There should be consideration for the 
existing trees on the site. There is a 
significant tree survey, which we will 
import for coordination purposes.

7. In the Vectorworks Preferences dialog 
box, choose the Interactive tab, choose 
the "Show acquisition hints" box.

8. Click the OK button to close the dialog 
box.

 

Adjust the Constraints Categories
Click the play button below to view 
a video of the following steps.

1. Choose>Tools>SmartCursor Settings…
2. Dismiss the handy Did you know...? 

dialog box by clicking OK.
3. In the SmartCursor Settings dialog box, 

click the Reset button.
4. Click the Yes button to accept the Are 

you sure...? dialog. Select General in 
the Category listbox on the left.

5. Uncheck the Snap to Combined Page 
Area box.

6. Select Object in the Category listbox 
on the left.

7. Select the Nearest Point on Edge box.
8. Select Smart Edge in the Category 

listbox on the left.
9. Select the Acquire Edge if mouse 

follows edge for 0.5 seconds.
10. Select Snap to Extension lines option.

11. Choose the OK button to close the 
dialog box.

12. In the Snapping palette, select the 
categories as shown.






20 | Vectorworks Architect 2012 Getting Started Guide Vectorworks Architect 2012 Getting Started Guide | 21

We will merge these classes into a single class for convenience. Note: This step is greatly 
simplified from the typical real-life workflow. However, the fundamental import>review>organize 
workflow is accurately represented. Note: For larger scale projects where the resources are 
larger and more complex, Vectorworks Architect offers the Design Layer Viewport>shuttle file 
workflow which, while requiring more effort to set up, is much more configurable, capable, and 
supports live updates.

Merge the Classes of the Imported 
Objects into One New Class
1. Choose Tools >Organization… the 

Organization dialog box appears.
2. In the Organization  dialog, choose the 

Class tab. In the upper left, and then 
click the New... button in the lower left.

3. In the New Class dialog, enter "Site" 
into the Name field. In the Creation 
options, enable the Edit Properties 
After Creation box, so that we are 
offered the class properties on closing 
this dialog box. Click the OK button to 
dismiss the New Class and Edit 
Class(es) dialog boxes.

4. In the Edit Class(es) dialog box, check 
the Use at Creation box at the top of 
the Graphic Attributes group. Set the 
Fill group Style popup to «None», and 
the Pen group Color popup to «Red», 
and set the opacity slider to 50%. 

We now have a class in which to merge 
all of the data from the survey without all 
of the extra classes cluttering up our class 
list. Now we will merge the classes into the 
new class. Note: For larger scale merging, 
Vectorworks Architect offers the Map Layers 
and Classes... command in the Tools menu.

There are seven tabs across the top of 
this dialog box that name the various 
organizational structures in Vectorworks. 
We will be using the first, Classes.

5. Click on the Classes tab.
6. In the listbox under the Class Name 

column, select all of the imported class 
names. Do this by a Command-Click 
(Mac) or Control-Click(Windows) on 
each of the names, as shown.

7. Click the Delete...button in the lower 
portion of the Organization dialog box.

Click the play button below to view a video 
of the following steps.

Import the Tree survey
1. In this example file (the PDF that you 

are reading, as opposed to 
Vectorworks, which must be opened in 
Adobe Reader or Adobe Acrobat.), 
choose View>Show/Hide>NavigationP
anes>Attachments. The Attachments 
pane opens.

2. Locate the file SITESURV.DWG in the 
Attachments drawer and click the Save 
Attachment button. In the Extract File 
dialog box, note the name and assign a 
place on your storage device and click 
Save.

3. In Vectorworks, choose 
File>Import>Import Single DXF/DWG 
File...

4. In the Import DXF/DWG Files dialog 
box, locate and select the Site Survey 
file that we just extracted from the 
Exercise file and click the Open button 
in the lower part of the dialog box.

5. In the DXF DWG Import Options dialog 
box, choose the "This Scale" option in 
the Model Space group.

6. Click the Scale... button to the right of 
the option and choose the scale to 
match the drawing"s Design layer scale, 
i.e. 1/4 or 1:50. Uncheck center after import.

7. Choose the Graphic Attributes tab and 
in the Colors and Lineweights group, 
uncheck the Map Colors to Lineweights 
box. Then click the OK button.

The imported objects categorized by layers are brought in as classed Vectorworks objects into a 
layer named as the import file. Check the classes tab of the Navigation palette, and you'll see 
that several “SITE” classes were imported. If an individual object is selected, we can gain a bit of 
information about what it represents to the surveyor by examining the display in the Object Info 
palette. This helps give meaning to the lines and other types of objects that we see in the 
drawing window.
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Create Auditorium Shape
Click the play button below to view a video 
of the following steps.

Since the Auditorium will be the pivotal 
element, we will place the circle in the 
center of the drawing space. This is 
easily accomplished with the Create 
Object method of the circle tool.

1. Double-click the Circle tool to invoke the 
Create Object dialog.

In the dialog that follows, we want to configure 
the settings to accomplish two things: The 
circle should have a 9 meter or 30' radius, 
and the center of the circle should be the 
exact center of the drawing space (0, 0). 
Therefore we will enter 0 (zero) in the X and 
Y parameter fields. Uncheck the "Position 
at Next Click" box. so that Vectorworks 
Architect immediately places the circle at 
the origin when the OK button is clicked.

2. Click the OK button to accept the 
dialog.

8. In the Delete Class(es) dialog that 
appears, choose the Reassign all of 
the objects to class: option and 
choose «Site» from the adjacent popup 
box. Click OK to dismiss the dialog.

In the Organization dialog box that 
remains, the surveyor's classes that were 
imported have been deleted. The objects 
that were assigned to those classes have 
been reassigned to the Site class and will 
take on the attributes that we specified 
when we created the class earlier.

9. Click OK in the Organization dialog 
box.

10. In the View bar, click the Fit to Objects 
button to center the view on the visible 
objects, if necessary.

11. In the Navigation palette, hide the 
objects in the Site class by clicking in 
the Invisible column (second column) 
to the left of the Site class.

Let us move on to consideration for the main 
auditorium. The inspiration for this space 
comes from the medical training theatre form. 
See . This form also suggests an assembly 
space such as a congress of world leaders.

We'll start with a quick area calculation: Allow 150 people at 1.5 Sq.M/person or 15 Sq Ft/person 
in main auditorium including support space, egress, seating and presentation area. A 9 meter or 
30' radius circular form yields ~260 sq.M or ~2800 sq. ft. We now have enough information to 
draw the first shape.
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8. Click to complete the hexagon when 
this is cue is displayed.

The building form relies entirely on geometric 
relationships. Using the Guides feature and 
a few snap/constraint categories, we lay out 
the guide lines, that form the basis of the 
building footprint and interior spaces within.

With the hexagon selected, look in the Object 
Info palette and review what this palette 
reports about the hexagon. In particular, 
note the name of the object in bold at the 
top: Polygon. Also, scroll if necessary 
to the bottom of the palette and observe 
that the system reports the square area, 
perimeter, number of vertices, and other 
generally useful information. Now, when 
you execute the next step, be sure to watch 
the Object Info palette as you do so.

9. With the hexagon figure from the last 
step selected, run the menu command 
Modify>Decompose.

This operation converts the underlying 
polygon into its constituent simple line 
objects, which we will use to further 
develop the needed layout guidelines. It is 
occasionally difficult to see any difference 
in the display after performing an operation, 
especially for those new to Vectorworks 

Architect. That is where the Object Info 
palette comes in. You should make a habit 
of looking at the result in the Object Info 
palette, which will offer more information to 
help verify what you see in the display.

In this case, you will note at the top of the 
Object Info palette that the description lists 
six lines where it said Polygon before. There 
is also no area report and no perimeter. 
Another aspect to note is that the same 
figure on the page when composed of 
polygons, takes less space on disk and is 
more versatile when moving to 3D. With the 
corollary Decompose command, Vectorworks 
provides a method to have your model 
objects in the most useful form at all times.

Create Triangular Shapes from 
Several Faces of the Polygon 
Figure.

1. Select the Connect/Combine tool in the 
Basic tool palette.

2. Select the second mode, Dual Object 
Connect in the Tool bar.

Create the Layout Lines.

Now let us consider the support. We will 
assume a column-free space is desired in the 
auditorium. A rectangular grid will only give a 
maximum of four points on the circular shape, 
so let us inscribe a hexagon, which will provide 
more closely spaced support locations. 
Vectorworks Architect provides the generalized 
Regular Polygon tool for this purpose. We will 
place the hexagon inscribed inside the circle 
with flat faces vertical on the left and right.

Create a Hexagon Inscribed within 
the Circle

1. Select the Regular Polygon tool in the 
Basic Tool palette.

2. Select Inscribe mode (first button) in 
the Tool bar.

3. Set the Number of sides to six in the 
Tool bar.

4. Now, move the cursor within the circle.
The snap category settings produce small 
tickmarks called available snaps. These 
are produced dynamically as the cursor 
is moved over figures in the document 
that have the potential for interaction.

5. Move the cursor to the small cross-
shaped available snap indication at the 
center of the circle.

6. When the acquired snap appears, click 
once to start the hexagon figure.

7. Move the cursor to the top of the circle. 
Don't click yet!

The snap category settings produce a 
screen hint labeled "Top Center". The cursor 
should be within a few pixels of the actual 
top center of the circle to produce this hint.
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This tool and mode connects lines and other 
objects by clicking on the edges of each. For 
example, to form the triangle figure associated 
with face 1 in the illustration, click with the 
Connect/Combine tool on side 2 and side 6.

3. Click on face 5 of the hexagon and then 
on the face labeled 1 in the diagram. 
Repeat to form triangular figures related 
to face 4 and side 6.

Now in order to determine the width of the 
building, we'll lay in a triangle to help define 
the footprint of the support spaces. This 
step uses the Smart Point feature explained 
in the Demonstration section above.

Create Triangle Layout Lines.

1. Select the Line tool from the Basic tool 
palette.

2. With the Line tool selected, check in the 
Tool bar that the second mode 
Unconstrained Single Line mode is 
active.

3. With the Line tool selected, move the 
cursor to the tip of the new triangle 
formed below face 4.

The snap category settings produce a 
screen hint (tooltip-like display) labeled 
"End Point", which is produced when the 
cursor senses the underlying line segment.

4. Click once to start the line while the 
"End Point" Screen hint is shown.

5. Move the cursor up to the tip of the new 
triangle formed above face 6 in the last 
step.

Wait about two seconds for the Smart Point 
to appear (small red open square). If you 
hesitate or pause on other snappable areas 
in the drawing window, the desired Smart 
Point might disappear; just move the cursor 
back and wait again to toggle it back on.

6. With the Smart Cursor indication 
showing, move the cursor down and left 
to a point where the angle is 30° up and 
to the left of the first polygon click from 
the step we just completed. While 
screen hint shows 30°Align and the 
HUD shows A(ngle) field shows 120°) 
simultaneously with the 30° line from 
the Smart Point, click to complete the 
line.
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This operation is worth taking a moment 
to understand. Study the illustration, and 
if necessary, review the video at the end 
of this series of steps. With this deft move 
we are able to establish the length of the 
adjacent side of a right triangle in a single 
move without measuring. Once you own 
this operation, you will use it every day!

Now, complete the figure by drawing a line to 
connect the endpoint of the line that you drew 
to the tip of the triangle above hexagon face 4.

7. With the Line tool selected, move to the 
endpoint of the line completed in the 
last step. When the Endpoint screen 
hint appears, click the pointer to begin 
another line.

8. Move the cursor to the tip of the triangle 
formed above hexagon face 6. Click at 
the tip when the Endpoint screen hint 
is shown.

We can now derive the extents of the 
building footprint and the auditorium's 
relationship within it. For this step we'll 
again use the Smart Points to extend 
established reference points.

9. Select the Rectangle tool from the 
Basic tool palette and enable the first 
mode (Rectangle Mode) in the Tool bar.

10. Move the cursor to the tip of the upper 
right triangle constructed earlier above 
face 1 and click to start the rectangle 
while the screen hint 'Endpoint' is 
displayed.

11. Move the cursor to the square corner of 
the right triangle figure and press the 'T' 
key or wait two seconds to activate a 
Smart Point at this location.

Be careful not to click the pointer 
button at this time–just point. The 
next step explains when to click.

12. Now, move the cursor and establish a 
second Smart Point at the tip of the 
triangle below face 4.

13. With the two Smart Points established, 
move the cursor horizontally to the left 
(-Y direction) to the location where the 
extensions of the two Start Points 
intersect. Click the pointer when the 
"Horizontal / Align H" tooltip is shown.

If you are having trouble getting this Screen 
Hint to appear, try the Snap Loupe. This 
is a zoom feature that enlarges the area 
around the cursor for the purpose of picking 
out the correct Screen Hint or other snap 
condition. The default hot key is the 'Z' key, 
which can be typed at any time except when 
the activity involves entering some text 

notation. The feature works best when you 
place the cursor exactly over the point of 
interest first, before you press the 'Z' key.

 

Massing Development

We are at the point where we can begin 
to explore the massing. To keep things 
organized, we will add another Class to 
the file to make it easy to control visibility 
of the guide geometry separately from the 
massing. The other class that we created was 
the Guides class,which Vectorworks made 
when we initialized the Guides system.

Click the play button below to view a video 
of the following steps.

Create a New Class for the 
Massing Elements.
1. Choose Tools>Organization... to 

display the Organization dialog box.
There are seven tabs across the top 
of this dialog box naming the various 
organizational structures in Vectorworks. 
We will be using the first, Classes.

2. Click on the Classes tab.
At the bottom left of this dialog 
box are the function buttons.

3. Click the first button, New... to display 
the New Class dialog box.

4. Clear the Name field at the top and type 
"Massing" for the new class name.

5. With the Edit Properties After 
Creation box checked, click the OK 
button to add the new class name to the 
file.

The Edit Class(es) dialog appears so we can 
edit the Class properties of the Massing class. 

6. Check the Use at Creation box at the 
top of this dialog box just below the 
Graphic Attributes label.

This box causes any objects that are 
in this class to be displayed with the 
properties set in this dialog box.

7. Below the Fill label in the upper left, 
make sure the Style popup is set to 
«Solid» and choose a very light color 
from the Color popup palette.

The Color palette popup can show several 
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2. Center the view on the visible objects 
by zooming and panning so that the 
rectangle efficiently fills the document 
window.

3. Select the Push/Pull tool from the 3D 
tool set.

4. Select the Extrude Face mode (first 
button) in the Tool bar.

5. Now, move the cursor within the area of 
the rectangle.

The tool highlighting feature covers the 
rectangle with a red fill. This indicates the face 
that will participate when the tool is activated.

6. While the rectangle is identified with the 
red tool highlighting, click once and 
move the pointer slightly up the screen. 
Do not click to finish the operation yet.

The rectangle is being transformed into a 
shape with a height. The material of the 
external walls is 12" CMU. The 16 courses of 
the typical 8" course height is 10'8". This is 
a two-story building so we will set the height 
of this 1st mass to 21'-4." We will address 
the foundation height later, if we get the job.

We will use the head-up display to 
enter the height of the building.

7. Before clicking to complete the push/
pull operation, press the Tab key on the 
keyboard to highlight the Distance field 
in the head-up display.

8. Without clicking the pointer, enter 21'4" 
(6.502m) (exactly as shown), and note 
that the height of the mass is locked 
when the Enter key is pressed.

9. Click the pointer once the height is 
locked to complete the operation.

The next series of steps will use the third 
mode (sub-face mode) of the Push/Pull tool 
to carve a variety of shapes in the mass. 
We'll start by drawing a polygon, using Smart 
Point extensions to place the corners

Create the North Indentation 
Polygon.
By default, the Active Plane popup located 
in the View bar is set to "Automatic". For 
the next few steps, we will be creating 
planar surface objects by snapping 
"through" the wireframe massing model 
to the guide lines that we created earlier. 
By temporarily setting the Active Plane 
to "Layer" we explicitly ask Vectorworks 
to draw on the Layer Plane. (Z=0).

1. Select the Polygon tool from the Basic 
tool set.

color lists including Classic, Standard, 
and Active Document. These are listed as 
rectangular buttons at the bottom of the popup. 
For now, choose the button labeled Standard 
Vectorworks Colors. (I am using the color 
labeled Cool White which is first in the third 
row of the Standard Vectorworks Colors list.)

8. Below the Color popup, set the Opacity 
slider to 60% Click OK.

9. Click the OK button at the bottom of the 
remaining Organization dialog box to 
return to the drawing window.

The next few steps will create some of 
the surface forms that we will use for 
the massing model, so we will make 
our new Massing class active.

10. Set this new Massing class to be the 
active class in the Active Class popup 
located in the View bar.

To start the massing model, we will use the 
last rectangle that we created in the last 
segment defining the basic building footprint.

11. Select the rectangle with the Selection 
tool in the Basic tool palette.

12. The rectangle takes on the attributes of 
the Massing class because we selected 
the Use at Creation option when we 
made the Massing class in the last 
segment.

13. Move the cursor to the upper right 
corner of the guide figure in the drawing 
window and click to start the rectangle 
while the screen hint labeled "Endpoint" 
is displayed.

14. Move the cursor to the lower right of the 
footprint rectangle and click when the 
screen hint labeled "Endpoint" is 
displayed. Place the circle in the 
Massing class.

15. Select the Circle tool. Place another 
circle on top of your guide circle. You 
will need this circle later in the exercise.

This finishes the rectangle operation. There 
are several snappable points available 
near this lower left corner including Object/
Symmetric, which may make it difficult 
to click while the screen hint labeled 
"Endpoint" is displayed. It may take a bit 
of wiggling to produce the correct cue. 

Create the Initial Massing Model 
Block.
We will create the massing model directly 
from the completed geometric layout above, 
and afterwards, we will derive the wall 
layout directly from the massing model.

1. Change the view to Left Isometric 
using the Current View popup in the 
View bar.
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Create the Entrance Slice Polygon
Slice a portion of the footprint to define 
the mechanical service area and also 
create a transition from the parking lot.

This step uses a planar polygon that we 
create by tracing our guide lines and 
referencing points with extensions and 
constraints, and then using the resulting 
polygon as the input for a sub-face mode 
push/pull operation. But first we'll...

1. Select the Polygon tool from the Basic 
tool set.

2. Select the Create Polygon From 
Vertices mode (first mode in the Tool 
bar).

We will use this polygon to create 
the subtraction polygon.

3. Move the cursor to the third vertex of 
the pentagon. Click to start. 

4. Move to the tip of the guide triangle 
below face four. The "Endpoint" screen 
hint will appear.

5. Wait about two seconds for the smart 
point to appear (small red open square) 
or press the 'T' key to activate a Smart 
Point at this location.

6. With the Smart Point visible, click the 
pointer to create the first vertex of the 
polygon.

7. Locate a Smart Point at the base of the 
inscribed hexagon at the bottom of the 
Auditorium circle, and form an extension 
line directly below (in the negative y 
direction) until the cursor is at the point 
where the extension intersects with the 
lower building footprint.

8. Click the pointer at this intersection to 
form the second segment of the poly 
defining the plan projection of the slot.

9. Move the cursor to the East edge of the 
building footprint guide. Move along this 
line until the "30°" screen hint appears. 
When the cursor is set to both touch the 
vertical footprint edge and will do so at 
30°, the "Object / 30°" screen hint, click 
the pointer to form the third vertex.

10. Click at vertex 3 of the pentagon to end.

2. In the Active Plane popup located in the 
View bar, select the "Layer Plane" item.

This should remain so set until you 
encounter an instruction to enable the 
automatic working plane once again.

3. Select the Create Polygon From 
Vertices mode (first mode in the Tool 
bar)

4. Move the cursor to the upper tip of the 
page northeast corner of the massing 
model at the ground plane (layer plane). 
The "Endpoint" screen hint will appear. 

5. With the Smart Point visible, click the 
pointer to create the first vertex of the 
polygon.

6. Move to the vertex formed by the 
hexagon guide faces 1 and 6, and click 
to begin the second segment of the 
polygon.

7. Move to the point of the triangle created 
off of face 6. Click to create the third 
segment.

8. Finish by moving the cursor back to the 
starting point. Double-click to end.
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Create the North Indentation.
This will form the indentation of the 
buildings north face, which features 
the circular auditorium shape beneath 
the angular upper floors.

1. Set the active plane popup in the View 
Bar to "Layer".

2. Select the Polygon tool from the Basic 
tool set.

3. In the Tool bar, select the "Create 
Polygon From Inner Boundary" mode 
(second button) and enable 
(Windows=blue; Mac=darken) the 
push/pull mode (third button).

4. Move the cursor, which now looks like a 
paint bucket, within the document 
window once it is within the triangle 
centered above the auditorium circle 
and bounded by the two upper guide 
line triangles. Be sure that the entire 
triangle in visible in the document 
window and that the entire paint bucket 
is within the triangle. Click the pointer.

At the click, Vectorworks creates a planar 
polygon on the layer plane formed by 
the building footprint and the extended 
hexagon guidelines. Because the push/
pull mode is enabled in the polygon tool, 
Vectorworks highlights the new polygon 
which we will use to modify the massing 
model with a solid subtraction. We will 
create this shape in the next step.

5. With the polygon highlighted, click the 
pointer once again to begin the extrude 
operation and move the cursor towards 
the northeast corner of the massing 
model. Click the pointer when the 
"Endpoint" cursor appears to set the 
height of the extrude to match the 
height of the massing model.

Using a variation of the push/pull function, 
which is incorporated into the polygon tool and 
enabled with the 'push/pull mode, we will now 
subtract the extrude from the massing model.

6. With the Extruded polygon still selected, 
select the Selection tool from the Basic 
tool palette and shift-click the edge of 
the massing model to add it to the 
selection.

7. With the two extrudes selected, run the 
Model>Subtract Solids... command. 
Use the arrows in the dialog that 
appears to highlight the massing model.

Vectorworks is asking you to highlight 
the shape that you want to keep.

8. When the massing model is highlighted, 
click the OK button.

Consideration for the Tree
To preserve an existing tree and to 
create a feature for the secondary exit 
from the pre-function gathering area, 
we'll make a feature that is geometrically 
related to the front entrance. 

So, with this polygon and the building 
massing model, we now have the pieces 
to create the entrance transition slot.

Click the play button below to view 
a video of the following steps.

Create the Entrance Transition 
Slot.
1. Select the Push/Pull tool from the 3D 

Modeling tool set.
2. Select the Sub Face mode (third mode 

in the Tool bar).
3. Move the cursor within the area of the 

polygon. When the red tool highlighting 
appears, indicating that the tool has 
detected a suitable planar sub-face, 
click the pointer.

4. Next click on a face of the wireframe 
building mass to define the second 
required input object, the solid.

5. Move the cursor back to within the 
polygon, and when the face of the 
polygon becomes red, click the pointer 
and move the cursor up to align the top 
face of the solid subtract object with the 
top surface of the building massing and 
click the pointer.

At the click, Vectorworks, subtracts the 
volume of the extruded polygon from the 
massing model to define the transition area 
and separate service building. Next, we'll 
try out a couple of variations to the Push/
Pull tools' functionality, including a new 
feature that now offers this functionality 
as a part of most planar tools.
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14. Move the pointer back down to 
horizontal, while maintaining a vertical 
extension line from the Smart Point. 
Click the pointer to finish the line when 
the "Horizontal / Align H" screen hint is 
displayed.

15. Move to the corner formed by the right 
triangle guides and click the pointer to 
start another line.

16. Move the cursor to the end point of the 
last drawn line and press the "T" key to 
designate a Smart Point. Don't click the 
pointer at this time.

17. Move the pointer back up to horizontal, 
while maintaining a vertical extension 
line from the Smart Point. Click the 
pointer to finish the line when the 
"30.00° / Align H" screen hint is 
displayed.

18. Now, to finish the figure, draw a line 
from the two endpoints of the last two 
lines drawn in this sequence.

As building designers we might consider any 
number of ways to address this challenge, 
from moving the building, since it is not 
built yet, to moving the tree, to adapting 
the design to accommodate the tree. Since 
we are modeling the workflow and not 
actually pondering the design process, 
we will adapt the building footprint to give 
the tree some breathing room as, I'm told, 
Architect Harry Weese did with the original.

First, we'll display the Site-Tree class 
that we imported earlier so that we can 
pinpoint the desired tree in context with 
our building mass. We'll also hide the 
massing model that we have created so far 
to make the guides simpler to work with.

1. In the Navigation palette, click the first 
tab (Classes) and make the "Site" class 
Visible by clicking in the first column 
across from the word "Site".

2. Hide the Massing class by clicking in 
the second column across from the 
Massing item in the list box.

3. Click in the checkmark column next to 
the Guides class in the list box to make 
it active.

4. In the Standard Views popup located in 
the View Bar select the Top/Plan item.

The tree location included with the site 
information is shown, and its drip line on 
the west side of the massing model extends 
deeply into the building footprint. We will 
first extend a line from one of the original 
hexagon faces to form the start point for the 
tree notch shape. We will extend one of the 
lines from the original inscribed hexagon to 
the West face of the building footprint outline.

5. Select the Connect/Combine tool in 
the Basic tool palette.

6. Select the Single Object Connect 
mode (first mode) in the Tool bar.

7. Now, move the cursor to the edge of the 
line that started out as the hexagon 
labeled side 6-1 in the diagram. When 
the cursor has detected the line, the tool 
will highlight the line with a bright red 
color.

The tool highlighting feature colors the line 
bright red. This indicates the edge that will 
participate when the tool is activated.

8. While the line is identified with the red 
tool highlighting, click on the line.

9. Then, click on the west face of the 
building footprint outline to extend the 
side 6-1 line to meet the west face 
building edge.

This is the origin point of the notch to 
provide breathing room for the tree.

10. Select the Line tool from the Basic tool 
palette.

11. Select the Unconstrained single line 
mode (second button) in the Tool bar.

12. Move to the end of the extended guide 
line on the west face of the building 
footprint. Click the pointer to start the 
line.

13. Move to the intersection of the extended 
line and the line of the right angle guide 
triangle, and press the "T" key to 
designate a Smart Point. Don't click the 
pointer at this time.
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2. Click with the paint bucket icon inside 
the two forms below the line and 
between the two vertical lines.

3. With the Shift key held down, click once 
in each of the triangles used to make 
the cut out for the tree.

4. Continue holding the Shift key down, 
click once again in the smaller triangle 
adjacent to the area just clicked to form 
a polygon representing the solar slot.

With the layout figures completed 
we can change the view to Isometric 
and create the solid shapes for 
subtracting from the building mass.

5. From the standard views pop up in the 
view bar choose left isometric.

6. Center the figure on the page with the 
Fit to Objects button also in the View 
bar, if necessary.

Carve Out the Solar Slot
1. From the toolsets palette select the 

Push/Pull tool and choose the 
Sub-Face mode (third button) in the 
Tool bar.

2. Move the cursor within the shape of the 
solar slot, and with the red highlighting 
showing, click the pointer once to 
indicate the polygon, then move to an 
edge of the building mass, such as the 
lower corner, to acquire the height, the 
massing model block. 

Use the form to remove the space below 
the second floor to create a covered porch 
area in front of the front door wall.

3.  Again, using the Push/Pull tool and 
Sub Phase mode, click with the paint 
bucket icon inside the form that defines 
the plan area of the front door porch. 

Move the cursor to the mid-point 
(elevation of the second-floor slab) of 
the right edge of the solar slot. Click to 
set the porch height, removing the 
massing below in front of the door.

4. Repeat this process for the tree cut-out.
 
We have completed the majority of the 
massing. Now we will now focus on the 
differences between the first floor round 
walls and the second-floor angular walls. 
You can use the wireframe view to find 
the differences between the first floor 
and second floor with guidelines.

 Remove the First Floor Masses
Carve out a void over the auditorium guide 
so that its characteristic shape will be freed 
from the building mass. We will make a simple 
rectangular polygon to make the sub face 
element for the Push/Pull tool in the next step. 
 
Click the play button below to view a video 
of the following steps.  

 
From the View Bar switch to Right Isometric 
view. Select the Polygon tool from the 
Basic tool palette and the Polygon from 
Vertices mode (first button) in the Tool bar.

1. Acquire a snap at the far northeast 
corner of the Building footprint and click 
for the first polygon segment. Move 
west across the north indentation to the 
end of the notch, and click to set the 
second vertex.

The main entrance will incorporate a 
slot to introduce natural light deeper 
into the gathering area and a recess 
to protect conference attendees from 
Aspen's cold evening breezes.

Click the play button below to view a video 
of the following steps.  

 
Create Guides for the Main 
Entrance Wall
This line will create a face for the door, 
and adjacent bank of windows. We'll start 
by adjusting the class visibilities to place 
the next figure onto the correct layer.

1. In the View bar, Choose to Top/plan 
item from the Standard views popup, 
and center the screen, if necessary, 
using the Fit Objects button in the view 
bar.

2. In the Navigation palette, click in the 
checkbox column across from the 
Massing class to make it active.

3. In the Navigation palette, turn off the 
Site class.

4. In the Navigation palette, select the 
Layer tab (second tab), and then 
choose active only from the layer 
options.

5. Center the figure on the page with the fit 
to objects button, also in the View bar, if 
necessary.

6. Select the Line tool from the Basic tool 
palette and the Unconstrained Line 
mode (second button), in the Tool bar. 
Move the cursor to the hexagon vertex 
between faces 4 and 5 of the hexigon.

7. Acquire an endpoint snap at the vertex 
and click the pointer to start the line.

8. Move the cursor down and to the left 
towards the adjacent side of the building 
bounds triangle.

9. Using the screen hint to maintain a 30° 
direction, click the pointer when you 
have reached the diagonal line and 
have acquired an object/perpendicular 
or "Object/30°" screen hint.

10. Click the pointer immediately at the 
endpoint to start another line.

11. Move the cursor vertically down to meet 
the building footprint clicking to finish 
when you have acquired the vertical/
object screen hint.

12. Start another line at the hexagon vertex 
between face 3 and 4. Move the cursor 
to the left and down towards the lower 
left corner of the building footprint. Click 
the pointer to finish the line. This line 
defines the front door and window wall 
face.

 The area below this window wall line will have 
a slot to let more light into the lobby area.

Define the First Floor Porch Plan 
Area.
1. Select the 2D Polygon tool from the 

Basic tool palette and the second button 
in the Tool bar (Polygon from the Inner 
boundary mode).
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4. Press tab on your keyboard to enter 
152.4 in the Length field, then press tab 
again, and Click to complete.

5. Click on the point of the triangle created 
off of face 6. Press tab on your 
keyboard to enter 152.4 in the Length 
field, then press tab again, and Click to 
complete.

6. Click on the point of the triangle created 
off of face 4. Press tab on your 
keyboard to enter 152.4 in the Length 
field, then press tab again, and Click to 
complete.

7. Select the 2D Polygon tool from the 
Basic Tool palette and choose the 
second mode, Create Polygon from 
Inner Boundary.

8. Click in the north triangle closest to the 
circle. 

9. Hold Shift and click again in the 
adjacent polygon to form a single 
triangle.

10. Click on the Selection tool in the Basic 
Tool palette. Press the Shift key and 
select the support column triangles.

11. Go to the Model menu, and select 
Extrude. 

12. Enter 325.1 in the Extrusion field. Click 
OK.

Next we will create the polygons for the 
columns and for the area that we cleared 
out for the emergency entrance. 

On the weather side, we will create a 
porch roof to provide shelter at the planned 
secondary exit by the cutout for the tree. 
Select the extrudes and place them in 
the Massing class. In the Navigation 
palette, make Massing the active class.

Create Roof in the Tree Niche
1. Change the view to Left Rear 

Isometric using the Standard View 
popup in the View bar.

2. In the View bar, click the Fit to Objects 
button to center the view on the visible 
objects, if necessary.

3. Select the 3D Polygon tool from the 
Modeling tool set.

4. Move the cursor to the left point of the 
tree niche at the roof and while the 
Endpoint screen hint is displayed, click 
once to start the 3D polygon operation.

2. Move directly south to the Hexagon 
vertex between face 4 and 5. Click to 
form the third polygon vertex, and move 
due east to the hexagon vertex between 
face 2 and 3.

3. Finish the polygon by moving North and 
click once on the  start point to finish the 
form.

4. From the Modeling Tool Set select the 
Push/Pull tool and the Sub Face mode 
(third button) in the Tool bar.

5. Move the cursor within the shape of the 
Polygon, and with the red tool 
highlighting showing, click the pointer 
once to indicate the polygon, then click 
once again on an edge of the massing 
block. Move to the "mid-point" available 
snap tick the set height of the void to 
the top of the second-floor slab.

Place the Auditorium Within the 
Massing
In the void created with the last step, pull the 
Auditorium circle with the Push/Pull tool up, 
to snap to the underside of the second floor.

1. Again with the Push/Pull tool, this time 
used with the Extrude Face mode (first 
button in the Tool bar) move to within 
the circular auditorium shape, and when 
the red tool highlighting is displayed, 
click to start the pull operation and set 
the auditorium height to the bottom  of 
the second floor slab by clicking on the 
lower point of the north indentation 
notch.

Since the auditorium was not actually 
combined with the massing block during 
the last step, we must do it manually now.

Add the First Floor Auditorium 
Volume to the Second Floor 
Massing
1. Select the first-floor auditorium cylinder 

together with the main massing block by 
holding the Shift key down as you click 
both objects.

2. With both objects selected, choose 
Model>Add solids 

Create a Guideline for the Rear 
Exit Door Wall Line
1. In the Navigation Palette, set the active 

class to Guides. Select the Line tool 
and move to the midpoint available 
snap tick of the hexagon guide at face 
2. Click to start the line and maintain the 
30° screen hint as you move the 
SmartCursor northwest.

2. As you intersect the vertical guideline 
from face 5, watch for the 30°/object 
screen hint. Click to finish the line.

Create the Support Columns
The footprint for the supporting 
columns at each second-floor triangular 
shape is five feet on each face.

1. In the Basic Tool palette, select the 
Regular Polygon and choose the third 
button (by face mode) in the tool bar.

2. Enter 3 in the Vertices field in the tool 
bar.

3. Click on the northeast corner of the 
model and drag along the diagonal line. 
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1. In the Navigation palette turn off the 
Massing class, and make the Guides 
class visible and active.

2. Select the Line tool from the Basic 
Tool palette. Place your cursor over top 
the point of the triangle at face 4. Wait 
for a second or press the ‘T’ key to set 
the smart point. Do not click at this time. 
Move your cursor to vertex 3 and create 
another smart point. Find the 
intersection of the smart points. Click to 
begin the line. 

3. Move your cursor to the right (towards 
the northeast end) and acquire the 30° 
screen hint. Click to end.

4. Select the Polygon tool, and the Inner 
Boundary mode in the Tool bar. Hold 
the Shift key and select the polygons 
shown in the image below. 
 

5. Go to the Model menu and select 
Extrude. Enter 18" (45.7cm). Click OK.

6. Select the 3D Flyover tool from the 
Basic Tool palette. Click the bottom left 
corner of the extrude to set your rotation 

point. Click, hold and move your mouse 
to rotate the image. Zoom in as 
necessary.

7. Select the Rectangle tool from the 
Basic Tool palette. With the first mode 
enabled.

8. Select Automatic Working Plane from 
the Plane drop down menu.

9. Click on the top center corner of the 
extruded porch. Move your mouse down 
and to the left, and press ‘tab’ to enter 
the Floating Data Bar.

10. Enter -27.9cm in the  ∆X, and press 
‘tab’.

11. Enter -15.2cm in the  ∆Y and press ‘tab’.
12. Click to finish.
13. Select the Selection tool from the Basic  

Tool palette. Holding the control key click 
and drag the rectangle down. Release 
the mouse.

14. Select the original rectangle.  Holding the 
control key click and drag the rectangle 
to the left. Release the mouse.

15. Holding the ‘Shift’ key select all three 
rectangles.

16. Go to the Modify>Add Surface.
17. Select the Push/Pull tool from the 3D 

Tool set. Select the third mode, 
‘Sub-Face Mode’.

18. Select the surface, and then Select the 
extrude.

5. Move the cursor to the right point of the 
tree niche at the roof and and while the 
Endpoint or Object / Y screen hint is 
displayed, click again to create the 
second 3D polygon vertex.

6. Move the cursor to the vertical midpoint 
of the right vertical edge at the stert of 
the tree niche feature

7. While the Midpoint screen hint is 
displayed, click the pointer button to 
create the third 3D polygon vertex.

8. Make the Massing class your active 
class. Now move to the start of the 3D 
polygon and, with the Endpoint screen 
hint displayed, click on the start point to 
finish the roof.

Create the Front Porch and Stairs.
In order to incorporate an ADA—compliant 
ramp up to the entrance level, we will define 
the boundary shape for the front porch and 
stairs from a few existing guidelines.
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dialog box, click the inner arrows until 
the front porch extrude is highlighted in 
red. Click OK. 

Create the Front Porch Extension
1. In the Object Info palette, change the 

class to Massing in the Classes 
drop-down.

2. In the View bar, change the active class 
to Massing in the Classes drop-down.

3. Change your view to Left Isometric in 
the Standard Views drop-down of the 
view bar. 

4. Select the Polygon tool from the Basic 
Tool palette and the third button (Inner 
Boundary Mode) in the Tool bar.

5. At the base of the solar slot, click in the 
area formed by the triangle guidelines 
on the ground. Press Shift and click in 
the polygon adjacent to the triangle to 
create a single shape.

6. Select the Push/Pull tool in the 3D 
Modeling tool set with the first button 
(Extrude Face Mode) enabled. 

7. Click on the polygon and pull up, 
moving the pointer to the upper edge of 
the front portch to set the height.

8. Select the Selection tool from the 
Basic Tool palette. Select the extension 
just formed and with the Shift key 
down, click on the fronch porch object. 

9. Right click on an edge of the front porch 
and select Add Solids from the context 
menu. 

10. Go to the View Menu and select 
Rendering>OpenGL.

Create the Windows
1. Go to Tools>Organization. In the first 

tab (Classes) click New.  Name the 
class Glazing. Click OK.

2. In the new class dialog box, check the 
Use at Creation box. In the Fill group 
change the Style to Solid, and the color 
to medium blue. Click OK. Click OK to 
close the Organization dialog. 

3. Select the Rectangle tool from the 
Basic Tool palette with the first button 
(Rectangle Mode) enabled in the Tool 
bar. 

4. Go to the Navigation palette. In the 
Classes tab, make the Glazing class 
active by clicking in the check box 
column. Turn the visibility for the 
Massing class on. 

5. Select the Rectangle tool and the 
Push/Pull mode.

6. Using the Elevations as a guide, 
draw rectangles at each window 
illustration as shown. 

19. Select the face again, and push it toward 
the right to the corner of the porch. Click 
to end. 

Create the ADA Ramp from the 
Parking Lot
We will create a filler in the solar slot area 
to extend the front porch. 
1. Select the Flyover tool from the Basic 

Tool palette. Click on the edge of the 
indendation of the step extrude to set 
the rotation axis. Rotate clockwise by 
dragging to the left until the east end of 
the porch steps are in view.

We’re now going to create a face within 
the volume to be the surface of the ramp. 

2. Select the Set Working Plane tool from 
the 3D Modeling tool set. Make sure the  
first button (Three Point mode) in the 
Tool bar is enabled. 

This mode takes three points to define 
the plane of the ramp. 

3. Click on the top left corner of the ramp. 
Now click on the top right corner of the 
ramp at 18”. Last, click on the lower 
right corner of the ramp, at 0”.

The ramp face is now defined by the 
working plane. 

4. Select  the Rectangle tool from the 
Basic Tool palette with the first button 
(Rectangle Mode) in the Tool bar.

5. Click once on the top left corner of the 
ramp to begin. To finish the rectangle 
move to the bottom right corner at 0”. 
Click to finish the rectangle.

6. Select the Push/Pull tool from the 3D 
Modeling tool set with the third button 
(Sub-Face Mode) enabled in the Tool 
bar.

7. Select in sequence the Rectangle, the 
Porch object, and the highlighted 
Rectangle face. Pull up 18” or more to 
create the subtraction volume. Click to 
end. 

Trim the Front Porch to match the 
Auditorium Cylinder
1. Select the Flyover tool from the Basic 

Tool palette. Roate clockwise to display 
the rear or north face of the porch.

2. Select the Arc tool from the Basic Tool 
palette, and the Arc by Three Points 
mode (second button in the Tool bar). 
Confirm that the sixth button (Push/Pull 
mode) is enabled. 

3. Change the active plane to Layer Plane 
in the Active Plane drop-down in the 
View bar.

4. Click at the beginning of the ramp (back 
face). Click at the back face mid-point 
indendation. Click at the lower right of 
the front porch.

5. Pull the mouse up at least 18”. Click to 
end. This will form the trim line to match 
the auditorium cylinder.

6. Select the Selection tool from the 
Basic Tool palette. Select the front 
porch, and with the Shift key pressed, 
add the Extruded Arc to the selection.

7. Right Click on an edge of the Arc and in 
the context menu that appears, choose 
Subtract Solids. In the Select Object 
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7. Select the Extract tool from the 3D 
Modeling tool set. With the fourth 
button enabled (Extract Surface 
Mode), click on the inner window 
wall abouve the porch steps.  

8. Click the green check mark in the 
Tool bar to create the surface. 

9. In the Object Info palette, change 
the NURBS Surface class to 
Glazing with the Classes drop-
down.

Classing the Front Porch
1. Go to Tools>Organization. In the 

Organization dialog in the Classes 
tab click New. Name the class 
Details. Click OK.

2. Check the Use at Creation box. In 
the Fill group, set the Style to 
Solid, and the Color to a medium 
brown. Click OK. Click OK again to 
close the Organization palette. 

3. Select the Selection tool from the 
Basic Tool palette, and select the front 
porch object. In the Object Info palette, 
click on the Classes drop-down, and 
select the new Details class.

Create the Elevations
Using the Modeling and Presentation 
methods detailed so far is about to get 
very interesting. We will create the plates 
for a client review by using Viewports to 
calculate all of the elevations, isometrics, 
and perspectives desired for review. We will 
also try a few different render techniques 
to give a few different looks to the plates. 
The methods that we will use come with 
the Architect product and do not require the 
Renderworks. More advanced rendering 
is available in the Renderworks product.

1. Choose View>Create Viewport 
2. In the dialog that appears, choose the 

settings as shown
3. Click OK.
The command results in a Viewport in a 
new sheet layer with the Layer, Class and 
projection displayed when the Viewport 
was created. For other viewports with 
similar settings, it is simpler to duplicate the 
Viewport object and change the appropriate 
parameters of the new  Viewport.

4. With the Viewport selected in the  Sheet 
layer from the previous step. Choose 
Edit>Duplicate...copy of the viewport is 
created and offset from the original.

5. Arrange the copy and original to make a 
plate with an over and under layout.

6. In the Object Info palette with the new 
viewport selected, change the View 
parameter popup from Front to Rear.

As you can see, creating presentation 
elements from a model is an efficient and 
flexible process. Taking the concept even 
further, we will now duplicate the whole sheet 
layer to present the left and right elevations.

7. In the Navigation palette, click the third 
tab (Sheet Layers) and Right-click on 
the Sheet item in the list box and in the 
context menu that appears at the 
cursor, choose Duplicate.

Even if you were watching the display, 

there is very little feedback to notice when 
Vectorworks duplicated the entire Sheet 
layer except that there is now an additional 
item in the sheet layer list, which is active. 
We can therefore edit the views of the two 
viewports to complete the elevation views.

8. Select the first Viewport separately and 
set View popup in the first Viewport to 
Right.

9. Select the second Viewport separately 
and set View popup in the first Viewport 
to Left.
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Section 4
Further Exploration
 

Drawing Organization

Introduction
Layers and classes provide a way to specify 
certain objects in a drawing to be members of 
a collection of related things. Once assigned, 
it’s easy to make all the members of the 
group visible, gray, or hidden in a drawing.

Layers and classes also help make a 
complicated drawing easier to use by 
distinguishing editable objects from those 
that are either only visible or snappable.

A drawing structured with layers and 
classes makes it easy to produce various 
views suitable for printing or review. Each 
view can refer to different combinations of 
the data model parts without the need for 
duplication. This method can also be used 
to organize the project in other ways, such 
as to assign materials for 3D representation 
and to extract quantities from a data model.

Layers as Pieces of Paper
When creating small projects in a CAD 
system, there’s usually no need to pay 
much attention to layers and classes 
because in a small project, you draw 
what you need and then print it.

When transitioning from drafting on a 
board with a pencil to using a CAD system, 
some folks draw onto the screen as if it 

were an electronic piece of paper. They 
use line objects to represent the graphite 
counterparts from their real world days 
with a pencil and a piece of vellum. One 
file produces one piece of paper.

Once they are drafting like this for awhile, 
some folks begin to store multiple drawings in 
a single project file by placing each drawing 
onto a new layer. At least initially, these folks 
might copy the parts of the drawing that repeat 
from one layer to the other to use as a base 
for the next drawing. Using this slightly more 
efficient approach, you can get more than 
one piece of paper out of a single CAD file, 
displaying one layer at a time while printing.

Systems Drafting Approach
For now, let’s think of layers as clear sheets 
of paper that can hold scaled figures. 
Sometimes folks discover that you can use 
the layer feature like the clear mylar sheets 
of Systems Drafting, which promoted the 
reuse of common elements on more than 
one drawing by separating elements that 
repeated onto separate sheets of mylar.

Some folks use layers in their CAD drawings 
as clear sheets of paper. Using this strategy, 
you can reuse certain parts of your drawing 
that appear on more than one piece of paper. 
As an example, you can create layers for 
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plan elements, overhead elements, and 
walls, which appear in both. By displaying 
the walls layer with the plan and overhead 
elements in succession, you can represent 
two pieces of paper with these three layers.

Building on this strategy, you can structure 
files to represent the pieces of paper for the 
plan and overhead of each floor of a three-
level building; for example with a wall, plan, 
and overhead layer for each floor. In this 
case, you can get six pieces of paper from the 
various permutations of the nine layers used.

But wait a minute, Architectural projects 
often have fifty or more sheets! That would 
necessitate layers for HVAC, plumbing, 
electrical, fire protection and so on. Using 
a one-dimensional structural scheme such 
as this for large scale projects could easily 
produce a list of 300 or more layers. In fact, 
some CAD systems with a one-dimensional 
layer system do just this, as you may 
have experienced if you ever imported a 
drawing generated in one of these CAD 
systems and examined the layer list.

A Second Dimension
Enter Classes as a second dimension of 
organization. With an array of layers and 
classes available for organizing a drawing, 
it is possible to create files equivalent to the 
organization of 300 layers with just 10 layers 
and 30 classes. This dramatically reduces 
list management and provides for some 
interesting additional efficiencies as well.

So, how do I decide on a scheme for 
structuring a drawing? One question I 
hear often is: Should I put this object in a 
Layer or a Class? This of course, is a trick 
question because each object in Vectorworks 
is always on a layer and assigned to a 

class. But seriously, how do I decide on 
an organizational scheme? Well, one 
approach to use is to note that layers and 
classes have slightly different properties.

Layer and Class Attribute 
Differences
The feature common to both layers and 
classes is object visibility. I can show or 
hide members of a class or layer with a 
click. I can also instantly set all members 
of any layer or class to a muted or grayed 
look. Let’s look at the other properties to 
see how layers differ from classes.

We’ve already seen that layers can be 
assigned a scale. You can’t do that with 
classes. So, if the layout of one of your 
printed sheets has figures in more than one 
scale, then you can show multiple layers, 
with each layer set to the appropriate scale. 
Layers also have a height in Z space. So, this 
suggests that layers can be a place to put 
things that all reference the same height. So 
when I set the height of a layer, the heights 
of all 3D objects on that layer are changed. 
In particular, they become an excellent way 
to represent architecture because I can 
divide it into floors or slices of Z space. 

Since layers have this physical height 
quality, you can represent a myriad of over 
and under relationships depending on the 
complexity of your project by stacking layers 
with the top of one layer exactly matching 
the bottom of the next layer. Remember, 
though, that layer heights can be specified 
in varying degrees of overlap. In fact, 
setting layer heights and thicknesses to 
perfectly overlap is a common approach 
to structuring special types of projects, 
such as some of those in the landscape 
and entertainment lighting industries. 

Classes, on the other hand, don’t have this 
physical height quality among their properties, 
but it does have the ability to display all of 
its members with the same graphic property, 
such as color or line thickness. This is not 
always needed, but as the project size 
becomes larger, it becomes more useful.

Showing all members of a class in a 
particular line size or color makes it 
possible to review a drawing visually for 
its structure. For example, if I see a green 
door and my exterior door class is supposed 
to be displaying in blue, I can recognize 
visually that it is in the wrong class.

Putting the Differences to Use
A question that frequently comes up at this 
point is: Are classes part of a specific layer? 
And the answer is No. While layers have a 
location in Z space and can be considered 
a container for its members, classes are 
more like attributes that are assigned to 
each member. A class can be applied to an 
object that is in any layer. Class members 
on a layer are not visible if the layer is turned 
off, even if the class visibility is turned on.

Thus, a simple class, Door, for example, 
can apply to objects on the first floor, the 
second floor, and so on, instead of having 
to have a Door First Floor class, a Door 
Second Floor class, and so on. So, for larger 
projects, classes can differentiate among 
objects in the same layer in order to define 
the separation needed to display different 
pieces of paper referring to the same floor.

For example, in order to set up a drawing 
with a first-floor electrical plan, and a first 
floor mechanical plan, I would define a 
layer—first floor—to contain the objects, and 
one or more classes for each of the needed 
sheets electrical, and mechanical, plus one 
or more classes for the elements that are 

shared between sheets, such as the walls. 
If I need to add a floor to the package, I just 
add a layer—second floor—to the file, and 
now I have all of the structure that I need to 
produce a set of electrical and mechanical 
sheets for the second floor as well.

Since class graphic attributes can also apply 
to the 3D representation of objects, classes 
become an efficient way to categorize objects 
in the file by material. Using this feature, 
I can define a texture to be used for each 
member of a class, for example, to represent 
the finish of all of the millwork in a project.

When structured this way, it becomes 
a simple matter to dramatically update 
the look of the 3D rendering, even late 
in the design process, by changing the 
classes’ texture attribute and having each 
of the members reflect that change after 
updating the images with Renderworks.

Adding on—A Scaleable Approach
This scheme is scaleable to describe more 
complex models or larger projects by dividing 
the floor volumes more finely. In a larger 
architectural project, for example, each layer 
representing the space between floors could 
be broken down into Slab, Walls, and Plenum. 

This makes it possible to manage more 
types of drawings a little more easily.

Slab layers can be set up to handle space 
planning, egress plans, area calculations, 
usage analyses, and other schematic tasks.

If the size of the project warrants it, 
Plenum layers can be set up to handle 
drawings such as mechanical plans, 
lighting plans, fire protection plans, 
reflected ceiling plans, and so forth.

This can simplify the use of classes 
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when used to separate project parts 
in a large drawing package.

Mixed Use Example
Class schemes can accommodate 
multiple purposes in the same file. 
Besides architectural floor levels, some 
of the reasons that I might use Classes, 
and or Layers in a project as follows:

• graphic control or standards
• visibility control
• categorize 3D objects by materials, 

by discipline or owner 

How do You Develop Standards?
• Review existing standards.
The problem of drawing organization has been 
addressed in countless ways. Find out how 
others have approached this problem. There 
are a number of resources and links provided 
in the Review the published standards, such 

as the AIA CAD layer guidelines to see how 
they might be adapted to your needs.

• Conduct a needs analysis.
• Determine what features you need.
• Characterize the nature of your projects.
• Draft!
It may be that the easiest way for you to 
begin this process is to open up a blank 
document with Design layer 1 and class 
None, and start drafting. Once you run into the 
need for separation, add layers and classes 
as you go. After the project is complete, 
there will be a valuable set of layers and 
classes with which to start other projects.

This initial standard should be considered 
a work in progress in that regular 
review, and use of the template will 
improve over time and in time, will 
become a perfectly tailored solution that 
represents all needed presentation and 
is adaptable and flexible for the future.

Creating Layouts with Sheet Layer Viewports

Introduction
One of the main purposes of drafting is 
to provide a way to describe a design 
to someone, who is not familiar with the 
project. With a 3D project, such as an 
architectural building, a landscape, or a 
scenic design, several views are necessary 
to adequately describe the project on 
a flat piece of paper. These views may 
include different types of plans, elevations, 
isometric views, and enlarged details.

When drafting was done with pencil and 
paper, the required views meant that a 
completely independent drawing had to be 
developed for each of the views. Each view 

was, in essence, a duplication of some part of 
model. Anytime that a change was introduced, 
each of the affected views had to be corrected 
to accommodate the change. Correcting the 
same part of the model in multiple views is 
more work than changing the model once. 
Also, the possibility of coordination errors 
is present each time duplicated information 
has to be corrected. One of the reasons that 
drafting systems were developed was to 
reduce the amount of duplication that these 
traditional drafting techniques required.

Drafting with a computer makes it possible 
to describe a design once as a model and 
project the information in various ways using 

the processing power of the machine to 
compute each view from the single model. 
Computers also build on this capability by 
providing efficient ways of organizing the 
model such as with layers and classes. 
This brings us to the need for Sheet Layer 
Viewports, which are a way to present multiple 
views simultaneously as they are needed on 
a sheet of paper, ready to send to the printer.

What is a Viewport?
A viewport is an object that can present 
various views and information on Sheet 
layers from a model on Design layers.

What are the benefits of Sheet 
Layer Viewports?
Sheet Layer Viewports allow us to 
create presentations that were difficult 
or impossible to create previously.

For example, two side-by-side views of a 
floorplan and reflected ceiling plan almost 
certainly required duplication of objects.

Using Sheet Layer Viewports, it is possible 
to combine multiple views of the design, 
at different scales, different orientations, 
and with different graphical looks.

Viewports increase drawing 
efficiency and reduce errors.

They are the perfect illustration of one of the 
basic rules of CAD, which is “draw it once.” 
Instead of creating an unconnected drawing 
for every view of the design, Sheet Layer 
Viewports allow us to project information from 
a single model in many different ways. And, 
because Viewports are dynamic projections, 
any changes that we make to the model are 
applied to all the Sheet Layer Viewports.

The provide a simplified drawing structure. 
Sheet Layer Viewports can be embellished 
with annotations that are specific to the 
viewport. Without this method, information 
that is used only once in a viewport would 
have to be added to a Design Layer and 
would have to be structured with additional 
classes to keep the information needed 
in each Viewport separately visible.

They provide a consistent place 
to manage your output
Sheet Layer Viewports and Sheet 
Layers simplify the drafting task by 
providing a consistent organization for 
storing and managing printed sheets. 
They also make it much easier for the 
software to provide features like the 
issue manager and to batch print. 

They provide better DWG compatibility
With Sheet Layer Viewports and Sheet 
Layers, Vectorworks has an organization 
schema that maps well to AutoCAD’s 
model/paper space. The result is much 
better compatibility with AutoCAD.

Viewport Requirements
In order to use Sheet Layer Viewports 
effectively, the file must be organized so 
that the project’s parts can be displayed 
independantly from one another. This means 
projects should be built using layers and 
classes to locate and categorize parts of 
the model so that they can be displayed 
in all of the ways that are needed to 
produce the various required views.

To make the most use of the viewport 
feature, files should be modeled 
using 3D or hybrid objects.
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Sheet Layer Viewports can still be used 
in files that have not been set up in this 
way, but some features demonstrated 
here might not be available.

Viewport Details
Sheet Layer Viewports reside exclusively on 
Sheet Layers, which are a new type of layer 
created to be a repository for Sheet Layer 

Viewports. Multiple Sheet Layer Viewports 
can reside on one sheet layer, and multiple 
sheet layers can be created in any file. So 
a single file can have enough sheets to 
produce an entire set of drawing plans.

Sheet Layer Viewports can display each 
of the required views of a project without 
duplicating the model. If the model 
changes, the Sheet Layer Viewports can 
be updated easily to reflect the changes.

Managing Drawing Resources

To increase efficiency, you can import 
resources into a file when it is first created. 
This increases efficiency because the 
resources are available for later use.

Basic Concepts of Resources and 
the Browser
Instances and Definitions
There are two parts to most resources, the 
definition, which is imported from file to 
file, and the instance, which is a reference 
to the definition, that is usually a part of the 
active file but also refers to a resource that is 
workgroup referenced from a different file.

Two Main Parts to the Resource Browser
The two main parts of the Resource Browser 
are (1) the part associated with the files, 
and folders functionality, and (2) the part 
associated with the resources functionality.

In the top part of the Resource 
Browser there are two labels 
corresponding to these two parts. 

The Files and Folders menu is used 

for navigation, and the Resources 
menu is used for viewing.

The Browser is a two-way concept. It 
imports from and exports to library files.

Using the Resource Browser
Open the Formatting Worksheets 
file. The Resource Browser opens 
wide to show resources.

The Resource Browser brings with it 
the concept of Favorites, which are 
designated files also known as Libraries, 
which contain resources. These resources 
are available to any active file.

The top drop-down menu shows open 
files above the divider in a list and below 
the divider are the designated favorites.

Select one of these files to make it current.

The second popup shows the 
hierarchy of resources within the 
current favorite or open file.

To quickly access a resource, click 
in the resource display window and 

begin typing the resource’s name. The 
resource display window scrolls to the 
first resource using the letters entered.

The currently active symbol is identified at 
the bottom of the Resource Browser. Be 
aware that the symbol highlighted in the 
window may not be the active symbol.

To make sure the selected resource 
activates double-click the Resource or 
right click and select Make Active.

Once active, depending upon resource 
type, the resource can be inserted into an 
object or anywhere else in the drawing.

Resources can also be inserted without 
being the active resource. Simply click and 
drag the resource to its desired location.

Editing Resource Definitions
Resources must be imported into the 
current document in order to be edited.

Once you have done so in the current 
document, right click the Resource and select 
Edit. An Edit dialog will populate depending 
upon which resource type is selected.

Mapping Instances
Select the object(s) to texture. If more 
than one object is selected, only the 
texture resource can be selected. 
Mapping parameters can only be set 
for individually selected objects.

From the Render tab, select the desired 
Texture from either the default resources 
or the current file’s resources, and then set 
the texture parameters, which apply only 
to the selected object. Because Object Info 
palette changes apply only to the selected 

object, one texture can be applied with 
different parameters to many objects.

 Instances may also be mapped by 
simply clicking and dragging the desired 
instance onto the appropriate object 
and then making changes to mapping 
parameters as necessary through the 
Render tab in the Object Info palette.

Additionally, instances can be mapped by 
selecting the appropriate object(s) and 
right-clicking the desired resource and 
selecting apply. Again changes can be made 
via the Object Info palette as desired.

The basic mapping parameters display in the 
Object Info palette. Click Mapping to access 
advanced mapping items and dialog box. 

Once a record format has been created, it 
can be attached to any object or symbol in the 
same drawing file as the record format. The 
Data tab of the Object Info palette indicates all 
record formats currently available to attach.

Methods
Attach a record format to a single symbol 
instance or to an object in the drawing without 
affecting previous or future instances.

With the desired object selected, click the 
Data tab from the Object Info palette. The 
Object Info palette lists all record formats 
in the drawing. Place an X in the desired 
record format box to attach the record.

The record can also be applied by 
selecting the desired objects and then 
from the Resource Browser selecting 
the record format to be applied. From 
the context menu, select Apply.

Alternatively, double-click the record 
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format resource to apply it to the 
selection or drag the record format 
resource onto a symbol or object.

Attaches a record format to a symbol 
definition that applies to each symbol 
added to the drawing afterwards. 
Existing instances remain unaffected.

Select a resource definition and 
then select Edit. Select the symbol 
component to edit, and click Edit. 

With nothing selected, click the Data 
tab in the Object Info palette. When no 
items are selected, the Data tab displays 
*SYMBOL DEFAULTS* at the top. 
Select the record to attach. Click on the 
exit symbol button when complete.

The attached record(s) is included 
with the symbol each time the symbol 
is placed in the drawing or imported 
into another drawing. Symbols already 
present in the drawing are unaffected.

Creating a Resource
Create from the resource browser.
To create a new resource select New 
Resource in <current document> from the 
Resources menu, or right-click in the Resource 
browser window to access the same menu.

Select the Resource type to make 
from the list, and the resource-type 
specific dialog box will open. 

Once created, the resource appears 
in the Resource Browser.

For quick resource creation, right-click 
in an area of the Resource Browser that 
is associated with an existing resource 
type. The context menu contains an 

additional option for quickly creating 
another resource of the same type.

Symbols must be created by using the Modify 
> Create Symbol command with the desired 
object to be created into a symbol selected.

The Create Symbol command creates 
symbols from 2D and/or 3D objects, 
including text. Symbols can also be 
created from other symbols, from plug-
in objects, groups, and worksheets.

Special Cases
Hybrid symbols
A hybrid symbol contains both a 2D 
object and a 3D component, and displays 
correctly according to the view.

To create a hybrid symbol, select both the 
2D and 3D objects. In Top/Plan view, align 
the objects first and then select Modify > 
Create Symbol. The resulting symbols will 
be displayed in the Resource Browser.

Red symbols
A red symbol when placed is converted 
into a plug-in object. It has a specific 
insertion behavior and set parameters, 
and it can be modified, with many 
variations of the same object in the file.

At symbol creation, select Convert 
to Plug-in Object in the insertion 
options to specify a red symbol.

Changes to a red symbol definition affect 
future instances, but not existing ones.

Blue Symbols
A blue symbol when placed is 
converted into a group.

Any changes made to the symbol definition 
later have no effect on the group.

At symbol creation, select Convert 
to Group in the insertion options 
to specify a blue symbol.

Managing Resources
Getting resources into the active file
To move resources into the active 
file, right-click on the resource from 
the library file and select Import.

Resources are also added to the active 
document as they are used in the document.

Getting resources into libraries
To add resources to a specific library, 
select the desired library to add the 
resource to from the Top drop-down 
menu. Select Open current favorite 
from the Files and Folders menu.

Once the desired library file is open, resources 
can be imported from other libraries or 
documents or new resources can be created.

Once the changes are saved to the library file, 
the new resources are visible in the library.

Default content system
The more commonly used resources are 
available at the point of use while drawing, 
without having to first add them to the 
current file through the Resource Browser.

Default libraries are found at: My Computer 
> Local Disk(C:) > Program Files > 
Vectorworks > Libraries > Defaults 
and HD > Applications > Vectorworks 
> Libraries > Defaults respectively. 

The ability to use default resources is a 

preference contained on the Session tab 
of Vectorworks Preferences and can be 
disabled if default resource use is not desired

Default resources are available from a variety 
of dialog boxes that contain parameters 
allowing resource access. They are also 
available from the Attributes and Object 
Info palettes. Once a default resource 
is selected for use, it is automatically 
imported into the current file and displays 
in the Resource Browser. It can then be 
shared among other drawing files.

Creating custom default content
To make a custom resource available as a 
default resource: Import custom resources 
to a default resource file, add a custom 
resource file to a default resource folder, or 
create a custom resource file and place an 
alias of (Macintosh) or shortcut to (Windows) 
that file in a default resource folder.
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Section 5
Glossary

Glossary

Planes
Any surface defined by any three points. In Vectorworks, plane is the term 
used to identify the surface where 3D operations take place.

Automatic Working Plane
Attribute of 3D and most planar creation tools that identifies object faces as potential 
working planes for the next drawing operation. As the user gestures in the document 
window with a tool selected, faces under the cursor highlight as alignment candidates to 
be used if the user begins the tool operation. Active plane must be set to Automatic. 

Container Objects
Hybrid (adj.)
Capability of certain objects to provide a distinct plan view graphic when the projection 
is Top/Plan. This allows, for example, a schematic representation of a door with 
the symbolic door swing arc graphic when displayed in plan view. A concept in 
Vectorworks in which objects have 2D and 3D parts so that the same object can 
have a look in a 2D plan view that is different from it’s look in 3D views.

Resource
A structured drawing component in the active file or in a library, which provides consistency 
across projects and individual users as well as within large multiple-file projects. 
Resources provide a means of sharing objects to multiple members of a workgroup. 

A shareable drawing component that can be imported to the active file with the Resource Browser 
from any Vectorworks file created with the same version. Resources can only be edited if they 
are part of the active file. Some resources specify actual objects, such as a symbol resource. 
Other resources are essentially attributes that define properties objects, such as hatch resources. 
Still other resources are a series of settings that can save time, and enable consistency.



60 | Vectorworks Architect 2012 Getting Started Guide Vectorworks Architect 2012 Getting Started Guide | 61

Resource Browser
The central repository for all Vectorworks 
resources. It is a window into the resources 
in the active file and any other Vectorworks 
files on a computer or network. 

Viewports (DLVP, DLSVP)
An object that can calculate various views 
of a model, by using layer and class 
visibilities, projection, rendering, scale, and 
orientation parameters. Viewports are ideal 
for creating presentations from your model.

Viewport Annotations
Any viewport specific embellishment that is 
added to a special group within the Viewport. 
This can be notes and dimensions specific 
to the Viewport, as well as graphic objects to 
clarify or correct the Viewport calculation.

Design Layer
A place to draw the model. Design Layers 
have height, thickness, and scale among 
their most important attributes. Multiple 
Design Layers are often used in the 
development of the project model.

Sheet Layer
Sheet Layers make it easy to create 
printable plates that make up a hardcopy 
project package. They are the place to put 
Sheet Layer Viewports along with pasted 
graphics and Title Blocks in Vectorworks. 
Sheet Layers have an independent origin, an 
assignable resolution and printer definition. 
Sheet Layers always display and print in 
a scale of 1:1. The Sheet Layer Viewports 
residing on Sheet Layers each have their own 
independent scale and other parameters. 

Project
The design that you are developing and 

documenting in Vectorworks. Anything 
that you are designing or drafting.

Model
n. All of the information you need to describe 
your project. v. The process of building a 
digital representation of your project that 
efficiently documents all aspects of your 
project and quickly gives you flexibility and 
accuracy across the entire timeline. The 
guiding principal for constructing a well-formed 
model is to use structures that ensure there 
are no duplications of model components 
or assemblies at any level. Vectorworks 
uses Stories, Design Layers, Sheet Layers, 
Classes, Viewports, and References at the 
conceptual level to organize the model. 

The collection of objects, geometry, text, 
and other elements that make up a project. 
Generally, the preliminary purpose of the 
model is to eliminate duplications. When 
there are repeating elements in a project, the 
repeating elements are defined as instances, 
which reference a single element definition.

Presentation
The collective calculations of the model, 
created either with the aid of a computer or 
otherwise that, with value added clarifications, 
comprise the contracted specified deliverables 
among the project stakeholders. In 
Vectorworks, the presentation is made up of 
annotated Viewports on Sheet Layers. Lists, 
tables, and catalogs of parts, pieces, takeoffs 
and details are similarly calculated from the 
model and verified expert review. The model 
itself is not the presentation, although each 
of the stakeholders in a project readily share 
their parts of the model as a means of in-
progress communication and documentation. 
The presentation can resemble traditional 
plates in a drawing package, or may adhere 
to another standard as specified by the client.


	Section 1
	Section 2
	Tool Behaviors and Modes
	Unified View Integrated Environment
	Working, Automatic, and Layer Planes (Screen)
	Stacking Order
	Hybrid Objects
	Container Objects
	Preferences
	Workspace
	Tool Hot Keys/Menu Shortcuts
	Menu Bar, View Bar, Tool Bar, and Message Bar
	Document Window
	Information Modeling
	Section 3
	Classing the Front Porch
	Create the Windows
	Create the Front Porch Extension
	Trim the Front Porch to match the Auditorium Cylinder
	Create the ADA Ramp from the Parking Lot
	Create the Front Porch and Stairs.
	Create Roof in the Tree Niche
	Create the Support Columns
	Create a Guideline for the Rear Exit Door Wall Line
	Add the First Floor Auditorium Volume to the Second Floor Massing
	Place the Auditorium Within the Massing
	 Remove the First Floor Masses
	Carve Out the Solar Slot
	Define the First Floor Porch Plan Area.
	Click the play button below to view a video of the following steps. 

Create Guides for the Main Entrance Wall
	Consideration for the Tree
	Create the North Indentation.
	Create the Entrance Transition Slot.
	Create the Entrance Slice Polygon
	Create the North Indentation Polygon.
	Create the Initial Massing Model Block.
	Create a New Class for the Massing Elements.
	Create Triangle Layout Lines.
	Create Triangular Shapes from Several Faces of the Polygon Figure.
	Create a Hexagon Inscribed within the Circle
	Create the Layout Lines.
	

Create Auditorium Shape
	Merge the Classes of the Imported Objects into One New Class
	Import the Tree survey
	Preliminary Layout
	Initialize the Guides System
	Adjust the Constraints Categories
	Adjust the Preferences
	Quick Drawing Setup
	Benefits of Designing with a Digital Tool
	Section 4
	Default content system
	Managing Resources
	Special Cases
	Creating a Resource
	Using the Resource Browser
	Basic Concepts of Resources and the Browser
	Viewport Details
	Viewport Requirements
	Introduction
	How do You Develop Standards?
	Mixed Use Example
	Adding on—A Scaleable Approach
	Putting the Differences to Use
	Layer and Class Attribute Differences
	A Second Dimension
	Systems Drafting Approach
	Layers as Pieces of Paper
	Introduction
	Section 5



